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BIOS MCSDK 2.0 Getting Started Guide

BIOS Multicore Software Development Kit
Version 2.x
Getting Started Guide

Last updated: //

Introduction
The BIOS Multicore Software Development Kit (MCSDK) provides
the core foundational building blocks that facilitate application
software development on TI's high performance and multicore DSPs.
The foundational components include:

• SYS/BIOS which is a light-weight real-time embedded
operating system for TI devices

• Chip support libraries, drivers, and basic platform utilities
• Interprocessor communication for communication across

cores and devices
• Basic networking stack and protocols

• Optimized application-specific and application non-specific algorithm libraries
• Debug and instrumentation
• Bootloaders and boot utilities
• Demonstrations and examples

Specifically, this Getting Started Guide provides information on installing the BIOS Multicore Software
Development Kit, loading the EVM out-of-box demonstration application via JTAG, and running the out-of-box
demonstration application. It is expected the user has gone through the EVM Quick Start Guide provided with their
EVM and have booted the out-of-box demonstration application flashed on the device.
By the end of this Getting Started Guide the user should have:

• Installed CCS
• Installed latest Emulation Package
• Installed the BIOS-MCSDK Software
• Connected to the EVM via CCS/JTAG
• Loaded the out-of-box demonstration application onto the device via JTAG
• Executed the out-of-box demonstration application

http://processors.wiki.ti.com/index.php?title=File:TIBanner.png
http://processors.wiki.ti.com/index.php?title=File:C66x-multicore.jpg
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Useful Tip

After completing the material in this Getting Started Guide, it is recommended the user continue on to the BIOS MCSDK User’s Guide for
additional information on the MCSDK software elements and to get started with development using the BIOS-MCSDK.

Acronyms and Definitions
The following acronyms are used throughout this document.

Acronym Meaning

AMC Advanced Mezzanine Card

CCS Texas Instruments Code Composer Studio

CSL Texas Instruments Chip Support Library

DDR Double Data Rate

DHCP Dynamic Host Configuration Protocol

DSP Digital Signal Processor

DVT Texas Instruments Data Analysis and Visualization Technology

EDMA Enhanced Direct Memory Access

EEPROM Electrically Erasable Programmable Read-Only Memory

EVM Evaluation Module, hardware platform containing the Texas Instruments DSP

HUA High Performance Digital Signal Processor Utility Application

HTTP HyperText Transfer Protocol

IP Internet Protocol

IPC Texas Instruments Inter-Processor Communication Development Kit

JTAG Joint Test Action Group

MCSA Texas Instruments Multi-Core System Analyzer

MCSDK Texas Instruments Multi-Core Software Development Kit

NDK Texas Instruments Network Development Kit (IP Stack)

NIMU Texas Instruments Network Interface Management Unit

PDK Texas Instruments Programmers Development Kit

RAM Random Access Memory

RTSC Eclipse Real-Time Software Components

SRIO Serial Rapid IO

TCP Transmission Control Protocol

TI Texas Instruments

UART Universal Asynchronous Receiver/Transmitter

UDP User Datagram Protocol

http://processors.wiki.ti.com/index.php?title=File:Helpful_tips_image.jpg
http://processors.wiki.ti.com/index.php?title=BIOS_MCSDK_2.0_User_Guide
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UIA Texas Instruments Unified Instrumentation Architecture

USB Universal Serial Bus

Note: We use the abbreviation TMS when referring to a specific TI device (processor) and the abbreviation TMD
when referring to a specific platform that the processor is on. For example, TMS320C6678 refers to the C6678 DSP
processor and TMDSEVM6678L refers to the actual hardware EVM that the processor is on.

Supported Devices/Platforms
This release supports the following Texas Instrument devices/platforms:

Platform Development
Kit

Supported Devices Supported EVM

C6657 [1] TMS320C6657 [2] TMDXEVM6657L [3], TMDXEVM6657LE [3]

C6670 TMS320C6670 [4],
TMS320TCI6618 [5]

TMDSEVM6670L [6], TMDSEVM6670LE [6],TMDSEVM6670LXE [6],
TMDSEVM6618LXE

C6678 TMS320C6678 [7],
TMS320TCI6608 [8]

TMDSEVM6678L [9], TMDSEVM6678LE [9], TMDSEVM6678LXE [9]

What's in this Kit?
The kit contains:

• EVM Board: This board contains a Multicore System-on-Chip.
• Universal Power Supply: Both U.S. and European power specifications are supported.
• Cables: USB, Serial, and Ethernet cables are included to allow for host development.
• Software DVD: Software installers, documentation, factory images.
• EVM Quick Start Guide: Single page guide to get started run demos pre-flashed on board.

The Multicore EVM kit Software DVD includes:
• BIOS Multicore Software Development Kit installer
• Linux Multicore Software Development Kit tarball
• Code Composer Studio installer
• Factory image restoration process

The C66x EVMs will have the following content loaded in flash/EEPROM:
Note: The C6657 EVM has a 4 MB sized NOR.

Getting Started
This section will walk you through installing and using the BIOS Multicore Software Development Kit, including
how to flash and run the out-of-box demonstration application, HUA. It is expected that you have gone through the
EVM Quick Start Guide for your EVM and have booted the demonstration application flashed on the device.
The overall steps are:
1. Make sure your EVM hardware is set up
2. Install Code Composer Studio v5
3. Install latest emulation package
4. Install the BIOS-MCSDK 2.0
5. Use JTAG to load the application

http://processors.wiki.ti.com/index.php/Keystone_Device_Architecture
http://www.ti.com/product/tms320c6657
http://www.ti.com/tool/tmdxevm6657
http://www.ti.com/tool/tmdxevm6657
http://processors.wiki.ti.com/index.php?title=C6670
http://www.ti.com/product/tms320c6670
http://www.ti.com/product/tms320tci6618
http://www.ti.com/tool/tmdsevm6670
http://www.ti.com/tool/tmdsevm6670
http://www.ti.com/tool/tmdsevm6670
http://processors.wiki.ti.com/index.php?title=C6678
http://www.ti.com/product/tms320c6678
http://www.ti.com/product/tms320tci6608
http://www.ti.com/tool/tmdsevm6678
http://www.ti.com/tool/tmdsevm6678
http://www.ti.com/tool/tmdsevm6678
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6. Run the application

Hardware Setup
Follow instructions in one of the links below that correspond to the EVM that you are using
• TMDXEVM6657L EVM Hardware Setup [10] (use this link if you have a LE model)
• TMDSEVM6670L EVM Hardware Setup [11] (use this link if you have a LE or LXE model)
• TMDSEVM6678L EVM Hardware Setup [12] (use this link if you have a LE or LXE model)
• TMDSEVM6618LXE EVM Hardware Setup [13]

Installing Code Composer Studio
The BIOS-MCSDK 2.0 uses CCS v5. To install CCS please refer to the instructions provided in the CCSv5 Getting
Started Guide [14].
When installing Code Composer Studio you can choose to control what is installed. For example, you may not want
support for particular devices and ISA's. If you choose to do a custom installation, the following components must be
installed to support the MCSDK:

• SYS/BIOS 6
• IPC
• XDC
• All C6* DSP

Note: In Windows 7, install and run CCS/BIOS MCSDK in administrator mode, this will rule out issues with CCS
start-up and RTSC component recognition
Sample Custom Installation snap shot:

Select C6000 DSPs during Choose ISA option

http://processors.wiki.ti.com/index.php/TMDSEVM6657L_EVM_Hardware_Setup
http://processors.wiki.ti.com/index.php/TMDXEVM6670L_EVM_Hardware_Setup
http://processors.wiki.ti.com/index.php/TMDXEVM6678L_EVM_Hardware_Setup
http://processors.wiki.ti.com/index.php/TMDXEVM6618LXE_EVM_Hardware_Setup
http://processors.wiki.ti.com/index.php/CCSv5_Getting_Started_Guide
http://processors.wiki.ti.com/index.php?title=File:CCS-setup-01.JPG
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Installing Latest Emulation Package
The Emulation Package provides GEL files and XML files that are used to manually configure the EVM. It is
needed if you are planning to use CCS to load an application. Ultimately, this configuration should come from the
application itself.
The way to move to the latest version of the emulation package depends on the version of CCS that you are using:
• CCS 5.0.3 users:

• Download the emupack zip file from the BIOS-MCSDK download page
• Unzip to a temp directory (say c:\temp for windows OR ~/temp for Linux)
• Please follow the instructions as per README.txt provided in the zip file.

Note: Please note that for CCS 5.0.3, there are no updates for the XML files needed.
• CCS 5.1 users:

• Please install the emupack installer following the sequences as requested by the installer. This would update
the necessary GEL files and the XML files needed to configure the EVM.

Installing the BIOS Multicore Software Development Kit
• After installing CCS, the next step is to install the BIOS-MCSDK. Please make sure CCS is closed before the

installation of BIOS MCSDK. Some of the components installed by CCS may be updated by the BIOS-MCSDK
installer; see the Release Notes for full details of components included in the installer. The development
environment can be either Windows or Linux. The MCSDK installer allows you to choose the installation
directory. The MCSDK install may include several sub-components as indicated in the Release Notes; all of the
components will be installed in the same location.

Each software component comes as an eclipse plug-in. After installing BIOS-MCSDK, CCSv5 should recognize 
each of the plug-ins when it starts up. In CCSv5 window, Help->Help Contents will list all the available docs and

http://processors.wiki.ti.com/index.php?title=File:CCS-setup-02.JPG
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user can browse the docs from the help window.

Useful Tip

For CCS to discover the BIOS-MCSDK installation, install the BIOS-MCSDK package into one of the folders that CCS will be search by default. If
any other directory outside these paths are selected for the installation, manually add that path into the tool discovery path in CCS, by using
Window->Preferences menu in CCS. By default, CCS RTSC tool discovery paths are:

• C:/Program Files/Texas Instruments
• C:/[CCSv5_install_dir] (e.g.; c:/TI, if CCS is installed under c:/TI directory)

Getting the BIOS MCSDK

Please refer to Technical_Support_and_Product_Updates [15] link for getting the BIOS MCSDK software.
Note: Make sure CCS is closed before invoking the BIOS-MCSDK installer.

Run the Installer & Provide the installation path

On Windows OS
To install BIOS-MCSDK on your Windows PC run the MCSDK installer (bios_mcsdk_<version>_setupwin32.exe).
It is recommended to keep the default installation paths for CCS and the other components (e.g., "C:\Program
Files\Texas Instruments" and "C:\Program Files\Texas Instruments\ccsv5") or make sure that CCS and the other
components are installed along the same path. This allows CCS to auto discover the components and generally
makes things simpler.
On Linux OS
The instalation is tested on Ubuntu Linux distribution, but it expected to work on other Linux distributions as well.
After downloading the Linux installer, (bios_mcsdk_<version>_setuplinux.bin), please change the attribute of the
installer to executable and run the installer as shown below. chmod +x

bios_mcsdk_<version>_setuplinux.bin ./bios_mcsdk_<version>_setuplinux.bin

Note: If you are installing on a Windows 7 machine, modify the default path to "C:\Program Files\Texas
Instruments". Otherwise, some of the CCS projects in the release may not build properly.
Note: MCSA (Multicore System Analyzer) which includes UIA + DVT will be installed under ccsv5 directory (for
non CCSv5.1+ users only).
Note: The BIOS MCSDK installer might default to C:\Program Files(x86)\Texas Instruments for 64 bit machines.
There are some projects in the BIOS MCSDK which assumes the default MCSDK installation directory to be
C:\Program Files\Texas Instruments. The workaround would be to install BIOS MCSDK in C:\Program Files\Texas
Instruments folder, then all the projects will re-compile without any change. If it is installed in C:\Program
Files(x86)\Texas Instruments then minor tweaks might be required for few projects to re-compile.
The installer setup window would pop.
A sample setup window screen shot is shown as below.

http://processors.wiki.ti.com/index.php?title=File:Helpful_tips_image.jpg
http://processors.wiki.ti.com/index.php/BIOS_MCSDK_2.0_User_Guide#Technical_Support_and_Product_Updates
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Please note that there are two paths that are asked to be entered:
1. CCSv5 installation path: This is Not Applicable for those who are using CCSv5.1+
2. BIOS-MCSDK Destination folder: This is the root directory where BIOS-MCSDK software will be installed.

Please provide the install path to the PARENT ccsv5 directory to avoid manual RTSC discovery tool setup in
CCSv5. If this cannot be done, see notes below to manually configure CCS to search for components in other
directories.

http://processors.wiki.ti.com/index.php?title=File:Bios_mcsdk_setup.jpg
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Check/Uncheck MCSA depending on the CCS Version

Due to a compatibility issue with CCS 5.1 [16], the MCSA component is not selected by default in the installer. If
using CCS 5.0.3, please select this component to install it; starting from CCS 5.1, MCSA is included in the CCS
installer.

http://processors.wiki.ti.com/index.php/BIOS_MCSDK_2.0_User_Guide#Q:_Can_I_use_CCS_5.1_with_BIOS_MCSDK_2.0.3F
http://processors.wiki.ti.com/index.php?title=File:MCSA_uncheck.jpg
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Completing the Installation

After the installation of BIOS MCSDK, please invoke the CCSv5 and notice the new components that are installed
by BIOS MCSDK are discovered by CCSv5. Please check all the new discovered products and restart CCSv5.
A sample screen shot in CCSv5 discovering new products is shown as below.

Please note that if you have installed MCSDK or/and the compiler in a path other than the default installation path,
then you will need to tell CCS where to find these components.
The following instructions explain this process.

http://processors.wiki.ti.com/index.php?title=File:Discovered_Products.jpg
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Instructions to Add Compiler Path to CCS

In CCS go to ‘Window --> Preferences.” This should bring up a window as shown in the snapshot below. Here go to
‘Code Composer Studio --> Build --> Compilers’ and add the path to where you installed the compiler. In this
example, v7.3.4 was provided with CCS and v7.4.1 was subsequently installed. Once you add the path, CCS should
show “TI v7.4.1” in the “Discovered tools” section.

http://processors.wiki.ti.com/index.php?title=File:Compiler_Tool_Discovery_Path.JPG
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Instructions to Add RTSC Products to CCS

In CCS go to ‘Window --> Preferences.” This should bring up a window as shown in the snapshot below. Here go to
‘Code Composer Studio --> RTSC --> Products’ and add the path to the parent folder where you installed MCSDK.
Once you add the path, CCS should show the newly installed MCSDK software components in the “Discovered
tools” sub-window.

If MCSDK components are still not recognized by CCS

If you are using Windows 7, and after doing the above steps CCS still does not recognize all MCSDK components,
we'd recommend installing MCSDK from within CCS as follows:
a. Go to CCS, and select Help->Install New Software
b. Add the MCSDK repository (http:/ / software-dl. ti. com/ sdoemb/ sdoemb_public_sw/ bios_mcsdk/ eclipse/
mcsdk2x)
c. Choose SYS/BIOS MCSDK Features, and click Next.
d. Follow any instructions.
e. In the future to update components you can go to Help->Check for Updates, to automatically check this repository
for new revisions

http://processors.wiki.ti.com/index.php?title=File:MCSDK_Tool_Discovery_Path.JPG
http://software-dl.ti.com/sdoemb/sdoemb_public_sw/bios_mcsdk/eclipse/mcsdk2x)
http://software-dl.ti.com/sdoemb/sdoemb_public_sw/bios_mcsdk/eclipse/mcsdk2x)
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Sample Directory Structure after the installation

The BIOS-MCSDK install includes several sub-components, all of which (except for MCSA) will be installed in the
same location. This location can be choosen using "Destination Folder". The BIOS-MCSDK installer also requires
the location of an already installed CCSv5.0. This location is specified in "Code Composer Studio v5.0 Installation
Directory" (this is the location to the "ccsv5" folder).
Once the installation is complete all the BIOS-MCSDK components will be installed in the specified installation
directory. Each of the directories will be of the format <component_name>_<component version>. Please refer to
individual components release notes for detailed information on the components or package.
A sample directory structure after a typical BIOS MCSDK default installation is shown below

+---bios_6_32_04_49

+---ccsv5

+---cg_xml

+---edma3_lld_02_11_02_04

+---imglib_c66x_3_0_1_0

+---ipc_1_23_01_26

+---mathlib_c66x_3_0_0_0

+---mcsdk_2_00_02_14

+---ndk_2_20_04_26

+---pdk_C6657_1_0_0_01

+---pdk_C6670_1_0_0_14

+---pdk_C6678_1_0_0_14

\---xdctools_3_22_01_21

Use JTAG to Load the Application
The following steps will guide you through connecting the JTAG to the EVM. These instructions are for the
on-board XDS100 emulator on the TMDSEVMxxxxL EVM. For LE or LXE models, the procedure is similar except
as noted. For more information on the emulators, see the respective page for XDS100 or XDS560. A Target
Configuration File tells CCS how to connect to the EVM (they reference device specific files which have been
supplied and contain information about the EVM, SoC and interface being used). Without one, you will not be able
to load or debug applications over JTAG using CCS.
1. Set the EVM Boot Mode to "No Boot" and power on the EVM. See the respective EVM Hardware Setup [17]

page listed above for the Boot Mode table.
2. First time CCSv5 users needs to follow the steps described in CCSv5_Running_for_the_first_time [18] page.
3. The above procedure will open up the CCSv5 GUI.
4. Create a New Target Configuration, by selecting the tab File->New and clicking Target Configuration File.
5. Enter a configuration file name (say "evmc6678l_xds100v1.ccxml") in the file name field and hit finish button

(the procedure assumes you are using On-board XDS100-class USB emulation).
6. Select the connection type as "Texas Instruments XDS100v1 USB emulator" for XDS100 or "Blackhawk

XDS560v2-USB Mezzanine Emulator" for XDS560 in the drop down list and enter device number in the Device
search filed. Select the EVM device as specified in the Target Config figure and save the file by clicking Save
button.

7. Click View->Target configurations to list the available target configurations. The configuration file
(evmc6678l_xds100v1.ccxml) created above will be under "User Defined" section

8. Right click on the configuration file and select Launch Selected Configuration. This will launch the configuration
and open the debug view.

http://processors.wiki.ti.com/index.php?title=XDS100
http://processors.wiki.ti.com/index.php?title=XDS560
http://processors.wiki.ti.com/index.php/BIOS_MCSDK_2.0_Getting_Started_Guide#Hardware_Setup
http://processors.wiki.ti.com/index.php/GSG:CCSv5_Running_for_the_first_time
http://processors.wiki.ti.com/index.php?title=Media:Target_config_evmC6678l.png
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9. Right click on core0 and select Connect Target to connect to the target CPU. This step will require the board is
powered up and the PC is connected to the board using USB.

10. Most of the development and debugging will require CCSv5. For more information on CCSv5 see the CCSv5
Getting Started Guide [14] page.

Loading and Setting up the EVM with the Gel file

Note: The same target GEL file is used for all different EVM models of the same processor (L, LE, LXE).
After the target configuration is launched, the GEL file can be set for each core. Before executing any application it
is recommended to execute the GEL script Global_Default_Setup for the evmc66##l. The example below shows
how to load and execute the GEL script from the GEL file for TMDSEVM6678xxx EVM.
1. Click on the core on which the GEL file needs to be loaded and select Tools->GEL Files from the Tools Menu.

This is captured in the GEL Menu under CCSv5
2. Right-click on the first row of the empty

list to get a Load GEL command

.
3. Execute the Load GEL command.
4. Browse & Open the GEL file. The

evmc66xxl.gel GEL file is located under
<CCS Installation
Directory>\ccs_base_5.#.#.####\emulation\boards\evmc66xxl\gel
directory.

http://processors.wiki.ti.com/index.php/CCSv5_Getting_Started_Guide
http://processors.wiki.ti.com/index.php?title=File:CCSV5GelMenuSelect.JPG
http://processors.wiki.ti.com/index.php?title=File:CCSV5GelMenuSelect.JPG
http://processors.wiki.ti.com/index.php?title=File:Emptygelwindow.jpg
http://processors.wiki.ti.com/index.php?title=File:Emptygelwindow.jpg
http://processors.wiki.ti.com/index.php?title=File:Loadgelc6678l.jpg
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5. Run Global_Default_Setup from the
Scripts Menu.

Running the Demonstration Application
Demonstrations are pre-loaded on the EVM flash as indicated above [19]. The "out of box" demonstration is the High
Performance DSP Utility Application (HUA). The following instructions use CCS to load the application via JTAG.
From a Windows PC
1. Enter the CCS debug view, select Run->Load->Load Program. The Program File field browse to C:\Program

Files\Texas Instruments\mcsdk_2_##_##_##\demos\hua\evmc66##l\Debug and select hua_evmc66##l.out (this is
the default location). It will load the program in the selected core.

2. Click on Run->Resume to run the demo on the target. In CCS 5.0, click on Target->Run.
From a Linux PC
1. Enter the CCS debug view, select Run->Load->Load Program. The Program File field browse to

$HOME/ti/mcsdk_2_##_##_##/demos/hua/evmc66##l/Debug and select hua_evmc66##l.out (this is the default
location). It will load the program in the selected core.

2. Click on Run->Resume to run the demo on the target. In CCS 5.0, click on Target->Run.
Note: The HUA demo runs in Static IP or DHCP mode depending on the User Switch 2. Please see the Hardware
Setup section for information on switch settings and HUA Demonstration Guide for information on static IP
configuration.

http://processors.wiki.ti.com/index.php?title=File:Loadgelc6678l.jpg
http://processors.wiki.ti.com/index.php?title=File:Loadgelc6678l-success-exec-scripts.jpg
http://processors.wiki.ti.com/index.php?title=File:Loadgelc6678l-success-exec-scripts.jpg
http://processors.wiki.ti.com/index.php?title=BIOS_MCSDK_2.0_Getting_Started_Guide#What.27s_in_this_Kit.3F


BIOS MCSDK 2.0 Getting Started Guide 15

Note: The application will write messages simultaneously to the CCS console and the UART. Therefore you can use
either the CCS Console or a serial port program to see them. When using DHCP this is the only way to get the IP
address that was assigned to the unit (it will be displayed as Network Added: If-1 someip).
Settings for the serial port are

Baud Rate 115200

Data Bits 8

Stop Bits 1

Parity None

Hardware Flow Control None

After the application starts up you should see text similar to the following in the CCSv5 console and/or UART
program window:

[C66xx_0] Start BIOS 6

[C66xx_0] HPDSPUA version 2.00.00.11

[C66xx_0] Configuring DHCP client

[C66xx_0] QMSS successfully initialized 

[C66xx_0] CPPI successfully initialized 

[C66xx_0] PASS successfully initialized 

[C66xx_0] Ethernet subsystem successfully initialized 

[C66xx_0] eventId : 48 and vectId : 7 

[C66xx_0] Registration of the EMAC Successful, waiting for link up ..

[C66xx_0] Service Status: DHCPC    : Enabled  :          : 000

[C66xx_0] Service Status: THTTP    : Enabled  :          : 000

[C66xx_0] Service Status: DHCPC    : Enabled  : Running  : 000

[C66xx_0] Network Added: If-1:10.218.112.167

[C66xx_0] Service Status: DHCPC: Enabled: Running: 017 

The IP address received through DHCP in this case is 10.218.112.167. You can now open a web browser and in the
address bar enter the IP address obtained. It will open up the HUA demo page.
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For more information on HUA, see the HUA Demonstration Guide [20].

Technical Support and Product Updates
For technical discussions and issues, please visit
• C66x Multicore forum: http:/ / e2e. ti. com/ support/ dsp/ c6000_multi-core_dsps/ f/ 639. aspx
• BIOS Embedded Software forum: http:/ / e2e. ti. com/ support/ embedded/ f/ 355. aspx
• Code Composer Studio forum: http:/ / e2e. ti. com/ support/ development_tools/ code_composer_studio/ f/ 81/ t/

3131. aspx
• TI C/C++ Compiler forum: http:/ / e2e. ti. com/ support/ development_tools/ compiler/ f/ 343/ t/ 34317. aspx
• Embedded Processors wiki: http:/ / processors. wiki. ti. com
For local support in China, please visit
• China Support forum: http:/ / www. deyisupport. com
Note: When asking for help in the forum you should tag your posts in the Subject with “MCSDK”, the part number
(e.g. “C6678”) and additionally the component (e.g. “NDK”).
For product updates,
• Visit Multicore Software Development Kits: http:/ / focus. ti. com/ docs/ toolsw/ folders/ print/ bioslinuxmcsdk.

html
• Use the CCS/Eclipse Update Manager (see the User's Guide [15] for more information)
Note: The EVM comes with disks containing the MCSDK software and CCS. You can start with these or go to the
MCSDK software download site listed above to check for the latest updates and version. The BIOS-MCSDK release
download will also have pointers to applicable CCS and compiler release versions as well. Please review the release
notes and software manifest before downloading and/or installing the software.

http://processors.wiki.ti.com/index.php?title=File:HuaWelcomePage_2_00.jpg
http://processors.wiki.ti.com/index.php/MCSDK_HUA_Demonstration_Guide
http://e2e.ti.com/support/dsp/c6000_multi-core_dsps/f/639.aspx
http://e2e.ti.com/support/embedded/f/355.aspx
http://e2e.ti.com/support/development_tools/code_composer_studio/f/81/t/3131.aspx
http://e2e.ti.com/support/development_tools/code_composer_studio/f/81/t/3131.aspx
http://e2e.ti.com/support/development_tools/compiler/f/343/t/34317.aspx
http://processors.wiki.ti.com
http://www.deyisupport.com
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TMDSEVM6657L EVM Hardware Setup
This page will walk you through setting up your TMDXEVM6657L [1] Evaluation Module (EVM). These guidelines
also apply to the L and LE EVM models.
Note: Some of the steps in this section have been updated from those used in the EVM Quick Start Guide.

Hardware Setup Overview
The picture below shows the TMDXEVM6657L EVM and the locations of relevant switches and connectors.

Hardware Setup Steps
Warning: The EVM board is sensitive to electrostatic discharges (ESD). Use a grounding strap or other device to
prevent damaging the board. Be sure to connect communication cables before applying power to any equipment.
1. Attach the Ethernet cable

Using the Ethernet cable supplied, connect one end of the cable to the Ethernet port on the EVM and the other end to
your PC.
2. Connect the JTAG interface

Use the USB to USB mini-B cable provided. Connect the USB mini-B connector to the USB mini-B interface on the
EVM and the USB connector to your PC. This enables XDS-100 emulation and is directly useable by CCS. If you
are using a different JTAG, connect it now.
3. Verify Endian mode in the SW3 settings

The Endian mode should be set to Little Endian. SW3 also contains the boot device settings.

http://focus.ti.com/docs/toolsw/folders/print/tmdxevm6657.html
http://processors.wiki.ti.com/index.php?title=File:TMDSEVM6657L-image.jpg


TMDSEVM6657L EVM Hardware Setup 19

4. Verify boot mode in the SW3 and SW5 settings

The boot mode settings below enable NOR boot by loading the boot loader from EEPROM address 0x51.
5. Set User Switch for the demo application

The application needs an IP address. It can use either a static IP address (pre-configured) or it can request one using
DHCP. This is controlled by setting dip switch 2 of SW9.
User Switch 2 ON : DHCP
User Switch 2 OFF: Static IP

6. Attach the serial port cable

This EVM can use either a USB serial port or the standard DB-9 (use the cable shipped with the platform). By
default the shunts which control this on the platforms are set to use the USB by default. We recommend changing
them to use the DB-9 as there are no known issues with this approach.

http://processors.wiki.ti.com/index.php?title=File:TMD6657LSW3.png
http://processors.wiki.ti.com/index.php?title=File:TMD6678LSW9.png
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Note: If the USB serial port output does not work, ensure that the cable is connected directly to a USB port on the
PC/laptop rather than going through an extender or USB hub.
7. Connect the power cable

Connect the power cable to the EVM power jack on the board. To be ESD safe, plug in the other end of the power
cable only after you have connected the power cord to the board. Then turn on the board.

Boot Mode Dip Switch Settings
The EVM supports booting image from various devices (EEPROM, NAND or NOR) via IBL (at I2C address 0x51),
I2C EEPROM (at I2C address 0x50), and ROM Boot modes (such as Ethernet, SRIO, PCIe, SPI etc.) which address
the boot source directly from the ROM code. Below is the table showing the boot mode dip switch settings for
different boot mode that the EVM supports:

 Boot Mode DIP SW3 

(Pin1, 2, 3, 4, 5, 6, 7, 8) 

DIP SW5 

(Pin1, 2, 3, 4, 5, 6, 7, 8) 

IBL NOR boot on image 0 (default) (off, off, on, off, on, on, on, on)1,2,3 (on, on, on, off, on, on, on, on)4

IBL NAND boot on image 0 (off, off, on, off, on, off, on, on) (on, on, on, off, on, on, on, on)

IBL NAND boot on image 1 (off, off, on, off, off, off, on, on) (on, on, on, off, on, on, on, on)

IBL TFTP boot (off, off, on, off, on, on, off, on) (on, on, on, off, on, on, on, on)

I2C POST boot (off, off, on, off, on, on, on, on) (on, on, on, on, on, on, on, on)

ROM SPI Boot8 (off, on, off, off, on, on, on, on) (on, on, off, on, on, on, on, on)

ROM SRIO Boot5 (off, off, on, on, on, on, off, on) (off, on, on, off, off, on, on, on)

ROM Ethernet Boot6 (off, on, off, on, on, on, on, off) (on, off, on, off, off, on, on, on)

ROM PCIE Boot7 (off, on, on, off, on, on, on, on) (on, on, on, off, off, on, on, on)

No boot (off, on, on, on, on, on, on, on) (on, on, on, on, on, on, on, on)

Note: : C6657 currently does not support Image 1 for NOR boot.
Footnotes:

1. Pin 1 of SW3 is the endian pin, by default, it is set to off (Little Endian)
2. Pin 2-4 of SW3 are the boot mode pins, by default it is set to I2C boot mode (off, on, off)
3. Pin 5-8 of SW3 and pin 1-2 of SW5 are the boot parameter index pins for I2C boot (paramter index 0/1 for NOR
boot image 0/1, parameter index 2/3 for NAND boot image 0/1, parameter index 4 for TFTP boot). By default,
image 0 is programmed to offset byte address 0x0 on NOR, and 0x20000 (block 1 start address) on NAND, image 1
is programmed to offset byte address 0x4000000 on NAND.

http://processors.wiki.ti.com/index.php?title=File:TMDXEVM6657L-shunts.jpg
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4. Pin 4 of SW5 is the I2C address pin (off: 0x51, on: 0x50)  for I2C boot mode
5. This will set the board to boot from SRIO boot mode, with reference clock at 250 MHz, data rate at 3.125 GBs,
and lane setup 4-1x ports and DSP System PLL at 100 MHz.
6. This will set the board to boot from Ethernet boot mode, with SerDes clock multiplier x 4, core PLL clock at 100
MHz.
7. This will set the board to boot form PCIE boot mode, with PCIE in end point mode and DSP System PLL at 100
MHz.
8. This will set the board to boot from SPI NOR via the ROM code, with boot-table contents expected in the NOR.
24bit addressing has been set.
Please refer to Technical_Reference_Manual for the boot mode switch settings on the board.

Return to BIOS MCSDK 2.0 Getting Started Guide [2]
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TMDXEVM6670L EVM Hardware Setup
This page will walk you through setting up your TMDXEVM6670L [1] Evaluation Module (EVM). These guidelines
also apply to the LE and LXE EVM models.
Note: Some of the steps in this section have been updated from those used in the EVM Quick Start Guide.

Hardware Setup Overview
The picture below shows the TMDXEVM6670L EVM and the locations of relevant switches and connectors.

Hardware Setup Steps
Warning: The EVM board is sensitive to electrostatic discharges (ESD). Use a grounding strap or other device to
prevent damaging the board. Be sure to connect communication cables before applying power to any equipment.
1. Attach the Ethernet cable

Using the Ethernet cable supplied, connect one end of the cable to the Ethernet port on the EVM and the other end to
your PC.
2. Connect the JTAG interface

Use the USB to USB mini-B cable provided. Connect the USB mini-B connector to the USB mini-B interface on the
EVM and the USB connector to your PC. This enables XDS-100 emulation and is directly useable by CCS. If you
are using a different JTAG, connect it now.
3. Verify Endian mode in the SW3 settings

The Endian mode should be set to Little Endian. SW3 also contains the boot device settings.

http://focus.ti.com/docs/toolsw/folders/print/tmdxevm6670.html
http://processors.wiki.ti.com/index.php?title=File:TMD6670L.jpg
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4. Verify boot mode in the SW3 - SW6 settings

The boot mode settings below enable NOR boot by loading the boot loader from EEPROM address 0x51.
5. Set User Switch 2 for the demo application

The application needs an IP address. It can use either a static IP address (pre-configured) or it can request one using
DHCP. This is controlled by setting User Switch 2 to ON for DHCP and OFF for Static. See SW9.

6. Attach the serial port cable

This EVM can use either a USB serial port or the standard DB-9 (use the cable shipped with the platform). By
default the shunts which control this on the platforms are set to use the USB by default. We recommend changing
them to use the DB-9 as there are no known issues with this approach.
To change the shunts refer to the picture below.

Note: If the USB serial port output does not work, ensure that the cable is connected directly to a USB port on the
PC/laptop rather than going through an extender or USB hub.
7. Connect the power cable

Connect the power cable to the EVM power jack on the board. To be ESD safe, plug in the other end of the power
cable only after you have connected the power cord to the board. Then turn on the board.

Boot Mode Dip Switch Settings
The EVM supports booting image from various devices (EEPROM, NAND or NOR) via IBL, it also supports
ROM Boot modes, such as Ethernet, SRIO, PCIe, etc. Below is the table showing the boot mode dip switch settings
for different boot mode that the EVM supports:

http://processors.wiki.ti.com/index.php?title=File:TMD6670LSW9.png
http://processors.wiki.ti.com/index.php?title=File:TMD6670LShunts.jpg
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 Boot Mode DIP SW3 

(Pin1, 2, 3, 4) 

DIP SW4 

(Pin1, 2, 3, 4) 

DIP SW5 

(Pin1, 2, 3, 4) 

DIP SW6 

(Pin1, 2, 3, 4) 

IBL NOR boot on image 0 (default) (off, off, on, off)1,2 (on, on, on, on)3 (on, on, on, off)4 (on, on, on, on)

IBL NOR boot on image 1 (off, off, on, off) (off, on, on, on) (on, on, on, off) (on, on, on, on)

IBL NAND boot on image 0 (off, off, on, off) (on, off, on, on) (on, on, on, off) (on, on, on, on)

IBL NAND boot on image 1 (off, off, on, off) (off, off, on, on) (on, on, on, off) (on, on, on, on)

IBL TFTP boot (off, off, on, off) (on, on, off, on) (on, on, on, off) (on, on, on, on)

I2C POST boot (off, off, on, off) (on, on, on, on) (on, on, on, on) (on, on, on, on)

ROM SPI Boot8 (off, on, off, off) (on, on, on, on) (on, on, off, on) (off, on, on, on)

ROM SRIO Boot5 (off, off, on, on) (on, on, on, off) (on, off, on, off) (off, off, on, on)

ROM Ethernet Boot6 (off, on, off, on) (on, on, on, off) (on, off, on, off) (off, off, on, on)

ROM PCIE Boot7 (off, on, on, off) (on, on, on, on) (on, on, on, off) (off, on, on, on)

No boot (off, on, on, on) (on, on, on, on) (on, on, on, on) (on, on, on, on)

Footnotes:

1. Pin 1 of SW3 is the endian pin, by default, it is set to off (Little Endian)
2. Pin 2-4 of SW3 are the boot mode pins, by default it is set to I2C boot mode (off, on, off)
3. Pin 1-4 of SW4 and pin 1-2 of SW5 are the boot parameter index pins for I2C boot (paramter index 0/1 for NOR
boot image 0/1, parameter index 2/3 for NAND boot image 0/1, parameter index 4 for TFTP boot). By default,
image 0 is programmed to offset byte address 0x0 on NOR, and 0x4000 (block 1 start address) on NAND, image 1 is
programmed to offset byte address 0xA00000 on NOR, and 0x2000000 on NAND.
4. Pin 4 of SW5 is the I2C address pin (off: 0x51, on: 0x50)  for I2C boot mode
5. This will set the board to boot from SRIO boot mode, with reference clock at 250 MHz, data rate at 3.125 GBs,
and lane setup 4-1x ports and DSP System PLL at 122.88 MHz.
6. This will set the board to boot from Ethernet boot mode, with SerDes clock multiplier x 5, DSP System PLL clock
at 122.88 MHz.
7. This will set the board to boot form PCIE boot mode, with PCIE in end point mode and DSP System PLL at 100
MHz.
8. This will set the board to boot from SPI NOR via the ROM code, with boot-table contents expected in the NOR.
24bit addressing has been set.
Please refer to Technical_Reference_Manual [2] for the boot mode switch settings on the board.

Return to BIOS MCSDK 2.0 Getting Started Guide [2]
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TMDXEVM6678L EVM Hardware Setup
This page will walk you through setting up your TMDXEVM6678L [1] Evaluation Module (EVM). These guidelines
also apply to the LE and LXE EVM models.
Note: Some of the steps in this section have been updated from those used in the EVM Quick Start Guide.

Hardware Setup Overview
The picture below shows the TMDXEVM6678L EVM and the locations of relevant switches and connectors.

Note: Please refer to this picture [2] for the alpha/beta Lite EVM boards.

Hardware Setup Steps
Warning: The EVM board is sensitive to electrostatic discharges (ESD). Use a grounding strap or other device to
prevent damaging the board. Be sure to connect communication cables before applying power to any equipment.
1. Attach the Ethernet cable

Using the Ethernet cable supplied, connect one end of the cable to the Ethernet port on the EVM and the other end to
your PC.
2. Connect the JTAG interface

Use the USB to USB mini-B cable provided. Connect the USB mini-B connector to the USB mini-B interface on the
EVM and the USB connector to your PC. This enables XDS-100 emulation and is directly useable by CCS. If you
are using a different JTAG, connect it now.
3. Verify Endian mode in the SW3 settings

The Endian mode should be set to Little Endian. SW3 also contains the boot device settings.
4. Verify boot mode in the SW3 - SW6 settings

http://focus.ti.com/docs/toolsw/folders/print/tmdxevm6678.html
http://processors.wiki.ti.com/index.php?title=File:TMDXEVM6678L-image.jpg
http://processors.wiki.ti.com/index.php/File:TMD6678L.jpg
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The boot mode settings below enable NOR boot by loading the boot loader from EEPROM address 0x51.
5. Set User Switch for the demo application

The application needs an IP address. It can use either a static IP address (pre-configured) or it can request one using
DHCP. This is controlled by setting dip switch 2 of SW9.
User Switch 2 ON : DHCP
User Switch 2 OFF: Static IP

6. Attach the serial port cable

This EVM can use either a USB serial port or the standard DB-9 (use the cable shipped with the platform). By
default the shunts which control this on the platforms are set to use the USB by default. We recommend changing
them to use the DB-9 as there are no known issues with this approach.

Note: If the USB serial port output does not work, ensure that the cable is connected directly to a USB port on the
PC/laptop rather than going through an extender or USB hub.

http://processors.wiki.ti.com/index.php?title=File:TMD6678LSW9.png
http://processors.wiki.ti.com/index.php?title=File:TMDXEVM6678L-shunts.jpg
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Note: Please refer to this picture [3] for the shunts on the alpha/beta Lite EVM.
7. Connect the power cable

Connect the power cable to the EVM power jack on the board. To be ESD safe, plug in the other end of the power
cable only after you have connected the power cord to the board. Then turn on the board.

Boot Mode Dip Switch Settings
The EVM supports booting image from various devices (EEPROM, NAND or NOR) via IBL (at I2C address 0x51),
I2C EEPROM (at I2C address 0x50), and ROM Boot modes (such as Ethernet, SRIO, PCIe, SPI etc.) which address
the boot source directly from the ROM code. Below is the table showing the boot mode dip switch settings for
different boot mode that the EVM supports:

 Boot Mode DIP SW3 

(Pin1, 2, 3, 4) 

DIP SW4 

(Pin1, 2, 3, 4) 

DIP SW5 

(Pin1, 2, 3, 4) 

DIP SW6 

(Pin1, 2, 3, 4) 

IBL NOR boot on image 0 (default) (off, off, on, off)1,2 (on, on, on, on)3 (on, on, on, off)4 (on, on, on, on)

IBL NOR boot on image 1 (off, off, on, off) (off, on, on, on) (on, on, on, off) (on, on, on, on)

IBL NAND boot on image 0 (off, off, on, off) (on, off, on, on) (on, on, on, off) (on, on, on, on)

IBL NAND boot on image 1 (off, off, on, off) (off, off, on, on) (on, on, on, off) (on, on, on, on)

IBL TFTP boot (off, off, on, off) (on, on, off, on) (on, on, on, off) (on, on, on, on)

I2C POST boot (off, off, on, off) (on, on, on, on) (on, on, on, on) (on, on, on, on)

ROM SPI Boot8 (off, on, off, off) (on, on, on, on) (on, on, off, on) (on, on, on, on)

ROM SRIO Boot5 (off, off, on, on) (on, on, on, off) (on, off, on, off) (off, on, on, on)

ROM Ethernet Boot6 (off, on, off, on) (on, on, on, off) (on, on, off, off) (off, on, on, on)

ROM PCIE Boot7 (off, on, on, off) (on, on, on, on) (on, on, on, off) (off, on, on, on)

No boot (off, on, on, on) (on, on, on, on) (on, on, on, on) (on, on, on, on)

Footnotes:

1. Pin 1 of SW3 is the endian pin, by default, it is set to off (Little Endian)
2. Pin 2-4 of SW3 are the boot mode pins, by default it is set to I2C boot mode (off, on, off)
3. Pin 1-4 of SW4 and pin 1-2 of SW5 are the boot parameter index pins for I2C boot (paramter index 0/1 for NOR
boot image 0/1, parameter index 2/3 for NAND boot image 0/1, parameter index 4 for TFTP boot). By default,
image 0 is programmed to offset byte address 0x0 on NOR, and 0x4000 (block 1 start address) on NAND, image 1 is
programmed to offset byte address 0xA00000 on NOR, and 0x2000000 on NAND.
4. Pin 4 of SW5 is the I2C address pin (off: 0x51, on: 0x50)  for I2C boot mode
5. This will set the board to boot from SRIO boot mode, with reference clock at 312.5 MHz, data rate at 3.125 GBs,
and lane setup 4-1x ports and DSP System PLL at 100 MHz.
6. This will set the board to boot from Ethernet boot mode, with SerDes clock multiplier x 4, core PLL clock at 100
MHz.
7. This will set the board to boot form PCIE boot mode, with PCIE in end point mode and DSP System PLL at 100
MHz.
8. This will set the board to boot from SPI NOR via the ROM code, with boot-table contents expected in the NOR.
24bit addressing has been set.

http://processors.wiki.ti.com/index.php/File:TMD6678LShunts.jpg
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Please refer to Technical_Reference_Manual [4] for the boot mode switch settings on the board.

Return to BIOS MCSDK 2.0 Getting Started Guide [2]
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TMDXEVM6618LXE EVM Hardware Setup
This page will walk you through setting up your TMDXEVM6618LXE Evaluation Module (EVM).
Note: Some of the steps in this section have been updated from those used in the EVM Quick Start Guide.

Hardware Setup Overview
The picture below shows the TMDXEVM6618LXE EVM and the locations of relevant switches and connectors.

TMDXEVM6618LXE EVM
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Hardware Setup Steps
Warning: The EVM board is sensitive to electrostatic discharges (ESD). Use a grounding strap or other device to
prevent damaging the board. Be sure to connect communication cables before applying power to any equipment.
1. Attach the Ethernet cable

Using the Ethernet cable supplied, connect one end of the cable to the Ethernet port on the EVM and the other end to
your PC.
2. Connect the JTAG interface

Use the USB to USB mini-B cable provided. Connect the USB mini-B connector to the USB mini-B interface on the
EVM and the USB connector to your PC. This enables XDS-100 emulation and is directly useable by CCS. If you
are using a different JTAG, connect it now.
3. Verify Endian mode in the SW3 settings

The Endian mode should be set to Little Endian. SW3 also contains the boot device settings.
4. Verify boot mode in the SW3 - SW6 settings

The boot mode settings below enable NOR boot by loading the boot loader from EEPROM address 0x51.
5. Set User Switch 2 for the demo application

The application needs an IP address. It can use either a static IP address (pre-configured) or it can request one using
DHCP. This is controlled by setting User Switch 2 to ON for DHCP and OFF for Static. See SW9.

6. Attach the serial port cable

This EVM can use either a USB serial port or the standard DB-9 (use the cable shipped with the platform). By
default the shunts which control this on the platforms are set to use the USB by default. We recommend changing
them to use the DB-9 as there are no known issues with this approach.
To change the shunts refer to the picture below.

Note: If the USB serial port output does not work, ensure that the cable is connected directly to a USB port on the
PC/laptop rather than going through an extender or USB hub.
7. Connect the power cable

Connect the power cable to the EVM power jack on the board. To be ESD safe, plug in the other end of the power
cable only after you have connected the power cord to the board. Then turn on the board.

http://processors.wiki.ti.com/index.php?title=File:TMD6670LSW9.png
http://processors.wiki.ti.com/index.php?title=File:TMD6670LShunts.jpg


TMDXEVM6618LXE EVM Hardware Setup 30

Boot Mode Dip Switch Settings
The EVM supports booting image from various devices (EEPROM, NAND or NOR) via IBL, it also supports
ROM Boot modes, such as Ethernet, SRIO, PCIe, etc. Below is the table showing the boot mode dip switch settings
for different boot mode that the EVM supports:

 Boot Mode DIP SW3 

(Pin1, 2, 3, 4) 

DIP SW4 

(Pin1, 2, 3, 4) 

DIP SW5 

(Pin1, 2, 3, 4) 

DIP SW6 

(Pin1, 2, 3, 4) 

NOR boot on image 0 (default) (off, off, on, off)1,2 (on, on, on, on)3 (on, on, on, off)4 (on, on, on, on)

NOR boot on image 1 (off, off, on, off) (off, on, on, on) (on, on, on, off) (on, on, on, on)

NAND boot on image 0 (off, off, on, off) (on, off, on, on) (on, on, on, off) (on, on, on, on)

NAND boot on image 1 (off, off, on, off) (off, off, on, on) (on, on, on, off) (on, on, on, on)

TFTP boot (off, off, on, off) (on, on, off, on) (on, on, on, off) (on, on, on, on)

POST boot (off, off, on, off) (on, on, on, on) (on, on, on, on) (on, on, on, on)

ROM SRIO Boot5 (off, off, on, on) (on, on, on, off) (on, off, on, off) (off, off, on, on)

ROM Ethernet Boot6 (off, on, off, on) (on, on, on, off) (on, off, on, off) (off, off, on, on)

ROM PCIE Boot7 (off, on, on, off) (on, on, on, on) (on, on, on, off) (off, on, on, on)

No boot (off, on, on, on) (on, on, on, on) (on, on, on, on) (on, on, on, on)

Footnotes:

1. Pin 1 of SW3 is the endian pin, by default, it is set to off (Little Endian)
2. Pin 2-4 of SW3 are the boot mode pins, by default it is set to I2C boot mode (off, on, off)
3. Pin 1-4 of SW4 and pin 1-2 of SW5 are the boot parameter index pins for I2C boot (paramter index 0/1 for NOR
boot image 0/1, parameter index 2/3 for NAND boot image 0/1, parameter index 4 for TFTP boot). By default,
image 0 is programmed to offset byte address 0x0 on NOR, and 0x4000 (block 1 start address) on NAND, image 1 is
programmed to offset byte address 0xA00000 on NOR, and 0x2000000 on NAND.
4. Pin 4 of SW5 is the I2C address pin (off: 0x51, on: 0x50)  for I2C boot mode
5. This will set the board to boot from SRIO boot mode, with reference clock at 250 MHz, data rate at 3.125 GBs,
and lane setup 4-1x ports and DSP System PLL at 122.88 MHz.
6. This will set the board to boot from Ethernet boot mode, with SerDes clock multiplier x 5, DSP System PLL clock
at 122.88 MHz.
7. This will set the board to boot form PCIE boot mode, with PCIE in end point mode and DSP System PLL at 100
MHz.
Please refer to TMDXEVM6618LXE Technical_Reference_Manual for the boot mode switch settings on the board.

Return to BIOS MCSDK 2.0 Getting Started Guide [2]

http://processors.wiki.ti.com/index.php/BIOS_MCSDK_2.0_Getting_Started_Guide#1._Hardware_Setup
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License
THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR "LICENSE"). THE WORK IS PROTECTED BY COPYRIGHT AND/OR OTHER
APPLICABLE LAW. ANY USE OF THE WORK OTHER THAN AS AUTHORIZED UNDER THIS LICENSE OR COPYRIGHT LAW IS PROHIBITED.
BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS LICENSE. TO THE EXTENT THIS LICENSE MAY BE CONSIDERED TO BE
A CONTRACT, THE LICENSOR GRANTS YOU THE RIGHTS CONTAINED HERE IN CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS.
License
1. Definitions
a. "Adaptation" means a work based upon the Work, or upon the Work and other pre-existing works, such as a translation, adaptation, derivative work, arrangement of music or other alterations of a literary or artistic work, or

phonogram or performance and includes cinematographic adaptations or any other form in which the Work may be recast, transformed, or adapted including in any form recognizably derived from the original, except that a work
that constitutes a Collection will not be considered an Adaptation for the purpose of this License. For the avoidance of doubt, where the Work is a musical work, performance or phonogram, the synchronization of the Work in
timed-relation with a moving image ("synching") will be considered an Adaptation for the purpose of this License.

b. "Collection" means a collection of literary or artistic works, such as encyclopedias and anthologies, or performances, phonograms or broadcasts, or other works or subject matter other than works listed in Section 1(f) below,
which, by reason of the selection and arrangement of their contents, constitute intellectual creations, in which the Work is included in its entirety in unmodified form along with one or more other contributions, each constituting
separate and independent works in themselves, which together are assembled into a collective whole. A work that constitutes a Collection will not be considered an Adaptation (as defined below) for the purposes of this License.

c. "Creative Commons Compatible License" means a license that is listed at http:/ / creativecommons. org/ compatiblelicenses that has been approved by Creative Commons as being essentially equivalent to this License,
including, at a minimum, because that license: (i) contains terms that have the same purpose, meaning and effect as the License Elements of this License; and, (ii) explicitly permits the relicensing of adaptations of works made
available under that license under this License or a Creative Commons jurisdiction license with the same License Elements as this License.

d. "Distribute" means to make available to the public the original and copies of the Work or Adaptation, as appropriate, through sale or other transfer of ownership.
e. "License Elements" means the following high-level license attributes as selected by Licensor and indicated in the title of this License: Attribution, ShareAlike.
f. "Licensor" means the individual, individuals, entity or entities that offer(s) the Work under the terms of this License.
g. "Original Author" means, in the case of a literary or artistic work, the individual, individuals, entity or entities who created the Work or if no individual or entity can be identified, the publisher; and in addition (i) in the case of a

performance the actors, singers, musicians, dancers, and other persons who act, sing, deliver, declaim, play in, interpret or otherwise perform literary or artistic works or expressions of folklore; (ii) in the case of a phonogram the
producer being the person or legal entity who first fixes the sounds of a performance or other sounds; and, (iii) in the case of broadcasts, the organization that transmits the broadcast.

h. "Work" means the literary and/or artistic work offered under the terms of this License including without limitation any production in the literary, scientific and artistic domain, whatever may be the mode or form of its expression
including digital form, such as a book, pamphlet and other writing; a lecture, address, sermon or other work of the same nature; a dramatic or dramatico-musical work; a choreographic work or entertainment in dumb show; a
musical composition with or without words; a cinematographic work to which are assimilated works expressed by a process analogous to cinematography; a work of drawing, painting, architecture, sculpture, engraving or
lithography; a photographic work to which are assimilated works expressed by a process analogous to photography; a work of applied art; an illustration, map, plan, sketch or three-dimensional work relative to geography,
topography, architecture or science; a performance; a broadcast; a phonogram; a compilation of data to the extent it is protected as a copyrightable work; or a work performed by a variety or circus performer to the extent it is not
otherwise considered a literary or artistic work.

i. "You" means an individual or entity exercising rights under this License who has not previously violated the terms of this License with respect to the Work, or who has received express permission from the Licensor to exercise
rights under this License despite a previous violation.

j. "Publicly Perform" means to perform public recitations of the Work and to communicate to the public those public recitations, by any means or process, including by wire or wireless means or public digital performances; to
make available to the public Works in such a way that members of the public may access these Works from a place and at a place individually chosen by them; to perform the Work to the public by any means or process and the
communication to the public of the performances of the Work, including by public digital performance; to broadcast and rebroadcast the Work by any means including signs, sounds or images.

k. "Reproduce" means to make copies of the Work by any means including without limitation by sound or visual recordings and the right of fixation and reproducing fixations of the Work, including storage of a protected
performance or phonogram in digital form or other electronic medium.

2. Fair Dealing Rights
Nothing in this License is intended to reduce, limit, or restrict any uses free from copyright or rights arising from limitations or exceptions that are provided for in connection with the copyright protection under copyright law or other
applicable laws.
3. License Grant
Subject to the terms and conditions of this License, Licensor hereby grants You a worldwide, royalty-free, non-exclusive, perpetual (for the duration of the applicable copyright) license to exercise the rights in the Work as stated
below:
a. to Reproduce the Work, to incorporate the Work into one or more Collections, and to Reproduce the Work as incorporated in the Collections;
b. to create and Reproduce Adaptations provided that any such Adaptation, including any translation in any medium, takes reasonable steps to clearly label, demarcate or otherwise identify that changes were made to the original

Work. For example, a translation could be marked "The original work was translated from English to Spanish," or a modification could indicate "The original work has been modified.";
c. to Distribute and Publicly Perform the Work including as incorporated in Collections; and,
d. to Distribute and Publicly Perform Adaptations.
e. For the avoidance of doubt:

i. Non-waivable Compulsory License Schemes. In those jurisdictions in which the right to collect royalties through any statutory or compulsory licensing scheme cannot be waived, the Licensor reserves the exclusive right
to collect such royalties for any exercise by You of the rights granted under this License;

ii. Waivable Compulsory License Schemes. In those jurisdictions in which the right to collect royalties through any statutory or compulsory licensing scheme can be waived, the Licensor waives the exclusive right to collect
such royalties for any exercise by You of the rights granted under this License; and,

iii. Voluntary License Schemes. The Licensor waives the right to collect royalties, whether individually or, in the event that the Licensor is a member of a collecting society that administers voluntary licensing schemes, via
that society, from any exercise by You of the rights granted under this License.

The above rights may be exercised in all media and formats whether now known or hereafter devised. The above rights include the right to make such modifications as are technically necessary to exercise the rights in other media and
formats. Subject to Section 8(f), all rights not expressly granted by Licensor are hereby reserved.
4. Restrictions
The license granted in Section 3 above is expressly made subject to and limited by the following restrictions:
a. You may Distribute or Publicly Perform the Work only under the terms of this License. You must include a copy of, or the Uniform Resource Identifier (URI) for, this License with every copy of the Work You Distribute or

Publicly Perform. You may not offer or impose any terms on the Work that restrict the terms of this License or the ability of the recipient of the Work to exercise the rights granted to that recipient under the terms of the License.
You may not sublicense the Work. You must keep intact all notices that refer to this License and to the disclaimer of warranties with every copy of the Work You Distribute or Publicly Perform. When You Distribute or Publicly
Perform the Work, You may not impose any effective technological measures on the Work that restrict the ability of a recipient of the Work from You to exercise the rights granted to that recipient under the terms of the License.
This Section 4(a) applies to the Work as incorporated in a Collection, but this does not require the Collection apart from the Work itself to be made subject to the terms of this License. If You create a Collection, upon notice from
any Licensor You must, to the extent practicable, remove from the Collection any credit as required by Section 4(c), as requested. If You create an Adaptation, upon notice from any Licensor You must, to the extent practicable,
remove from the Adaptation any credit as required by Section 4(c), as requested.

b. You may Distribute or Publicly Perform an Adaptation only under the terms of: (i) this License; (ii) a later version of this License with the same License Elements as this License; (iii) a Creative Commons jurisdiction license
(either this or a later license version) that contains the same License Elements as this License (e.g., Attribution-ShareAlike 3.0 US)); (iv) a Creative Commons Compatible License. If you license the Adaptation under one of the
licenses mentioned in (iv), you must comply with the terms of that license. If you license the Adaptation under the terms of any of the licenses mentioned in (i), (ii) or (iii) (the "Applicable License"), you must comply with the
terms of the Applicable License generally and the following provisions: (I) You must include a copy of, or the URI for, the Applicable License with every copy of each Adaptation You Distribute or Publicly Perform; (II) You
may not offer or impose any terms on the Adaptation that restrict the terms of the Applicable License or the ability of the recipient of the Adaptation to exercise the rights granted to that recipient under the terms of the Applicable
License; (III) You must keep intact all notices that refer to the Applicable License and to the disclaimer of warranties with every copy of the Work as included in the Adaptation You Distribute or Publicly Perform; (IV) when
You Distribute or Publicly Perform the Adaptation, You may not impose any effective technological measures on the Adaptation that restrict the ability of a recipient of the Adaptation from You to exercise the rights granted to
that recipient under the terms of the Applicable License. This Section 4(b) applies to the Adaptation as incorporated in a Collection, but this does not require the Collection apart from the Adaptation itself to be made subject to
the terms of the Applicable License.

c. If You Distribute, or Publicly Perform the Work or any Adaptations or Collections, You must, unless a request has been made pursuant to Section 4(a), keep intact all copyright notices for the Work and provide, reasonable to the
medium or means You are utilizing: (i) the name of the Original Author (or pseudonym, if applicable) if supplied, and/or if the Original Author and/or Licensor designate another party or parties (e.g., a sponsor institute,
publishing entity, journal) for attribution ("Attribution Parties") in Licensor's copyright notice, terms of service or by other reasonable means, the name of such party or parties; (ii) the title of the Work if supplied; (iii) to the
extent reasonably practicable, the URI, if any, that Licensor specifies to be associated with the Work, unless such URI does not refer to the copyright notice or licensing information for the Work; and (iv) , consistent with
Ssection 3(b), in the case of an Adaptation, a credit identifying the use of the Work in the Adaptation (e.g., "French translation of the Work by Original Author," or "Screenplay based on original Work by Original Author"). The
credit required by this Section 4(c) may be implemented in any reasonable manner; provided, however, that in the case of a Adaptation or Collection, at a minimum such credit will appear, if a credit for all contributing authors of
the Adaptation or Collection appears, then as part of these credits and in a manner at least as prominent as the credits for the other contributing authors. For the avoidance of doubt, You may only use the credit required by this
Section for the purpose of attribution in the manner set out above and, by exercising Your rights under this License, You may not implicitly or explicitly assert or imply any connection with, sponsorship or endorsement by the
Original Author, Licensor and/or Attribution Parties, as appropriate, of You or Your use of the Work, without the separate, express prior written permission of the Original Author, Licensor and/or Attribution Parties.

d. Except as otherwise agreed in writing by the Licensor or as may be otherwise permitted by applicable law, if You Reproduce, Distribute or Publicly Perform the Work either by itself or as part of any Adaptations or Collections,
You must not distort, mutilate, modify or take other derogatory action in relation to the Work which would be prejudicial to the Original Author's honor or reputation. Licensor agrees that in those jurisdictions (e.g. Japan), in
which any exercise of the right granted in Section 3(b) of this License (the right to make Adaptations) would be deemed to be a distortion, mutilation, modification or other derogatory action prejudicial to the Original Author's
honor and reputation, the Licensor will waive or not assert, as appropriate, this Section, to the fullest extent permitted by the applicable national law, to enable You to reasonably exercise Your right under Section 3(b) of this
License (right to make Adaptations) but not otherwise.

5. Representations, Warranties and Disclaimer
UNLESS OTHERWISE MUTUALLY AGREED TO BY THE PARTIES IN WRITING, LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND CONCERNING
THE WORK, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE, MERCHANTIBILITY, FITNESS FOR A PARTICULAR PURPOSE,
NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER DEFECTS, ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR NOT DISCOVERABLE. SOME JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO SUCH EXCLUSION MAY NOT APPLY TO YOU.
6. Limitation on Liability
EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO YOU ON ANY LEGAL THEORY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE
OR EXEMPLARY DAMAGES ARISING OUT OF THIS LICENSE OR THE USE OF THE WORK, EVEN IF LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
7. Termination
a. This License and the rights granted hereunder will terminate automatically upon any breach by You of the terms of this License. Individuals or entities who have received Adaptations or Collections from You under this License,

however, will not have their licenses terminated provided such individuals or entities remain in full compliance with those licenses. Sections 1, 2, 5, 6, 7, and 8 will survive any termination of this License.
b. Subject to the above terms and conditions, the license granted here is perpetual (for the duration of the applicable copyright in the Work). Notwithstanding the above, Licensor reserves the right to release the Work under different

license terms or to stop distributing the Work at any time; provided, however that any such election will not serve to withdraw this License (or any other license that has been, or is required to be, granted under the terms of this
License), and this License will continue in full force and effect unless terminated as stated above.

8. Miscellaneous
a. Each time You Distribute or Publicly Perform the Work or a Collection, the Licensor offers to the recipient a license to the Work on the same terms and conditions as the license granted to You under this License.
b. Each time You Distribute or Publicly Perform an Adaptation, Licensor offers to the recipient a license to the original Work on the same terms and conditions as the license granted to You under this License.
c. If any provision of this License is invalid or unenforceable under applicable law, it shall not affect the validity or enforceability of the remainder of the terms of this License, and without further action by the parties to this

agreement, such provision shall be reformed to the minimum extent necessary to make such provision valid and enforceable.
d. No term or provision of this License shall be deemed waived and no breach consented to unless such waiver or consent shall be in writing and signed by the party to be charged with such waiver or consent.
e. This License constitutes the entire agreement between the parties with respect to the Work licensed here. There are no understandings, agreements or representations with respect to the Work not specified here. Licensor shall not

be bound by any additional provisions that may appear in any communication from You. This License may not be modified without the mutual written agreement of the Licensor and You.
f. The rights granted under, and the subject matter referenced, in this License were drafted utilizing the terminology of the Berne Convention for the Protection of Literary and Artistic Works (as amended on September 28, 1979),

the Rome Convention of 1961, the WIPO Copyright Treaty of 1996, the WIPO Performances and Phonograms Treaty of 1996 and the Universal Copyright Convention (as revised on July 24, 1971). These rights and subject
matter take effect in the relevant jurisdiction in which the License terms are sought to be enforced according to the corresponding provisions of the implementation of those treaty provisions in the applicable national law. If the
standard suite of rights granted under applicable copyright law includes additional rights not granted under this License, such additional rights are deemed to be included in the License; this License is not intended to restrict the
license of any rights under applicable law.

http://creativecommons.org/compatiblelicenses

